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Preface
Welcome to Jobscience Recruiting
Jobscience Recruiting is the most scalable, flexible, and customizable applicant tracking system available today. 
With pre-configured editions for corporate Human Resources, staffing agencies, and strategic sourcing teams, 
Jobscience Recruiting represents the next generation of talent acquisition technology. Built 100% natively on the 
Force.com platform, Jobscience applications deliver the same open, mobile, and collaborative capabilities that are 
expected in today’s social enterprise. As a three-time award winner of “Best HR & Recruiting App” by 
salesforce.com customers, Jobscience Recruiting allows you to manage professional, powerful, online job boards, 
integrate with social networks to connect with talent, and track candidates from application to placement.

About This Guide
The Jobscience Recruiting Requisition Management User Guide includes the following sections:

Chapter 1, Overview, provides a brief overview of the Managing application and describes how to log in to 
Jobscience and access the Managing application.

Chapter 2, Creating Requisitions, describes how to create, view, edit, delete, and clone requisitions.

Chapter 3, Approving Requisitions, describes how to submit a requisition for approval, as well as the process for 
approving requisitions.

Chapter 4, Creating Job Orders, describes how to create a Job Order for a requisition.

Chapter 5, Reports, provides basic report information, including creating, deleting, editing, running, scheduling, 
and exporting reports.

Chapter 6, Administration, describes administrative tasks that can be performed with the Jobscience Managing 
product.

Who Should Read This Document
This document should be read by anyone responsible for administering or using the Jobscience Managing 
product.

Related Documentation
The Jobscience documentation set contains the following manuals.

Jobscience Documentation

Document Description

Jobscience Recruiting 
Candidate Management User 
Guide

Provides information on using the Jobscience Candidate Management 
application.

Jobscience Recruiting Job 
Order Management User 
Guide

Provides information on using the Jobscience Job Order Management 
application.

Jobscience Recruiting 
Applicant Management User 
Guide

Provides information on using the Jobscience Applicant Management 
application.
Jobscience Managing Requisition Management User Guide (v. 3.5) vi



Preface
Jobscience Recruiting Job 
Board Management User 
Guide

Provides information on setting up and managing Job Boards within the 
Jobscience system.

Jobscience Recruiting Search 
Management User Guide

Provides information on how to manage the Jobscience Search function.

Jobscience Forms User 
Manual

Provides information on allowing clients to create online-based forms that can 
be set up to create new records or update existing records within an 
organization when a form is filled out and submitted.

Jobscience Enhanced 
Applicant Management 
System User Guide

Provides information on using the Jobscience Enhanced Applicant 
Management System.

Jobscience Managing 
Requisition Management 
User Guide

Provides information on using the Managing application to automate and 
streamline Human Capital Management processes.

Jobscience Recruiting 
Implementation Guide

Provides information on installing the Jobscience product.

Jobscience Documentation (cont.)

Document Description
Jobscience Managing Requisition Management User Guide (v. 3.5) vii



Preface
Notation Conventions
The following notation conventions are used throughout this manual.

Notation Conventions

Notation Description Example

ALL UPPERCASE Acronyms AMS
EEO

Blue type In text, the names of buttons and 
icons.

Click the OK button.
Click the Move icon.

courier type Directories, files names, parameters, 
and system messages.

The &ContactID parameter.

italic type Book titles. For more information, see the 
Jobscience Managing Requisition 
Management User Guide.

Green type In text, the names of tabs, dialogs, 
screens, and sections within a screen.

Click the Home tab.

Blue underlined type In text, hyperlinks. Click the date link at the right to 
display the calendar.

Maroon type In text, the name of fields, 
checkboxes, drop-down lists, text 
boxes, and columns.

Type your name in the Name field.
Jobscience Managing Requisition Management User Guide (v. 3.5) viii



Chapter 1: Managing Overview
Chapter 1
Managing Overview

Jobscience Managing is a powerful application that allows seamless integration and collaboration between Hiring 

Managers and Human Resources to automate and streamline Human Capital Management processes (for 
example, creating a requisition, having a requisition approved, receiving information on prospective Candidates, 
etc.). When Jobscience Managing is installed along with Jobscience Recruiting, Hiring Managers have access to 
the same platform that Human Resources is using, so there is no redundancy or duplicate data entry. Instead, 
managers are able to communicate with Human Resources quickly and effectively, as well as share essential 
information.

In This Chapter
Logging into Jobscience Managing.................................................................................................................. 2

Accessing the Managing Application ............................................................................................................... 2

Tabs ................................................................................................................................................................. 4
Jobscience Managing Requisition Management User Guide (v. 3.5) 1



Chapter 1: Managing Overview
Logging into Jobscience Managing
Logging into Jobscience Managing is the same as logging into your Salesforce instance.

To log into Jobscience Managing

1. Enter your user ID (typically your email address) into the User Name field.

2. Enter your password into the Password field.

3. Click Login to display the Home tab.

4. If you do not see the Jobscience Managing set of tabs, select “Managing” from the drop-down list at the upper 
right corner of the screen. For more information, refer to Accessing the Managing Application on page 2.

Accessing the Managing Application
When the Jobscience Managing application is installed, the “Managing” option is added to the drop-down list at 
the upper right corner of the main Jobscience screen.

To access the Managing application, select the “Managing” option from the drop-down list. The following screen 
displays.

Note: If you do not have access to this application, please contact your system administrator.
Jobscience Managing Requisition Management User Guide (v. 3.5) 2



Chapter 1: Managing Overview
Note: These are sample pages and items. Your instance may look different depending on the customizations 
you requested from Jobscience and additional customizations you performed internally.

Please remember that access to parts of the product are dependent on individual user permissions and 
license limitations. Not all users will have access to everything described in this document.
Jobscience Managing Requisition Management User Guide (v. 3.5) 3



Chapter 1: Managing Overview
Tabs
Once the Managing application is installed and accessed, the following tabs are displayed:

■ Home tab
■ Personnel Actions tab
■ Departments tab
■ Dashboards tab
■ Reports tab
■ + tab

The following sections provide a brief overview of each tab.

Home Tab
The Home tab is common for all applications. It contains the following three panels:

■ Dashboard
■ MyTasks
■ Calendar

Dashboard
The Dashboard panel displays data from source reports as visual components, which can be charts, gauges, 
tables, metrics, or Visualforce pages. They provide a snapshot of key metrics and performance indicators for your 
organization. Each dashboard can have up to 20 components, but only the top three are displayed.

MyTasks
The MyTasks panel displays a List View of your incomplete tasks.

Calendar
The Calendar panel displays a List View of future events and a calendar. You may select any item to view its 
details.

■    Selects personal data.

■    Selects data for all users.

■    Selects activity data.

■    Displays list views of the selected data for the current day.

■    Displays list views of the selected data for the week.

■    Displays list views of the selected data for the month.

Note: Your instance may look different depending on the customizations you requested from Jobscience and 
additional customizations you performed internally.

Please remember that access to parts of the product are dependent on individual user permissions and 
license limitations. Not all users will have access to everything described in this document.
Jobscience Managing Requisition Management User Guide (v. 3.5) 4



Chapter 1: Managing Overview
For more information about the Home tab, refer to the Salesforce documentation.

Personnel Actions Tab
When the Personnel Actions tab is selected, the Personnel Actions Home page is displayed. From this page 
you are able to create new requisitions for open positions within your organization.

For more information about the Personnel Actions tab and creating requisitions, refer to Creating Requisitions on 
page 7.

Departments Tab
When the Departments tab is selected, the Departments Home page is displayed. From this page you are able to 
identify and view each of your company’s departments. You can also view the positions within each department 
and the pay grade that is associated with each position.

Dashboards Tab
When the Dashboards tab is selected, the Dashboard Adoption Dashboard page is displayed. From this page 
you are able to view data from source reports as visual components, which can be charts, gauges, tables, metrics, 
or Visualforce pages. They provide a snapshot of key metrics and performance indicators for your organization. 
Each dashboard can have up to 20 components. It is similar to the Dashboard panel on your Home tab except that 
the Dashboards tab provides additional information.

Reports Tab
When the Reports tab is selected, the Reports Home page is displayed. From this page you can perform 
numerous actions, including searching for reports, viewing, creating, editing, and deleting reports, scheduling, 
running, and exporting reports, and selecting or creating folders.

For more information about reports, refer to Reports on page 21.

+ Tab
The + tab is common for all applications. When the + tab is selected, you can navigate to and manage the tabs that 
appear on your screen.

Note: The actions you are able to perform are dependent upon your individual user permissions. If you need 
assistance with your permissions, please contact your system administrator.
Jobscience Managing Requisition Management User Guide (v. 3.5) 5



Chapter 1: Managing Overview
From the + tab you may:

■ Click on any icon or link to display that tab
■ Filter the display of icons by selecting a different view
■ Customize the default set of tabs that appear on your screen

For more information about the + tab, refer to the Salesforce documentation.
Jobscience Managing Requisition Management User Guide (v. 3.5) 6



Chapter 2: Creating Requisitions
Chapter 2
Creating Requisitions

When a hiring manager has an open position which needs to be filled, either because someone left the company, 

moved on to a new position within the company, or was terminated, the first thing the hiring manager needs to do is 
create a new requisition. A requisition initiates the hiring process by specifying the position that needs to be filled, 
along with as many details about the position as possible. The more information that is provided in the requisition, 
the better equipped the recruiter will be to find the best possible Candidate for the position.

In This Chapter
Creating Requisitions....................................................................................................................................... 8

Viewing Requisitions .......................................................................................................................................11

Editing Requisitions ....................................................................................................................................... 13

Deleting Requisitions ..................................................................................................................................... 14

Cloning Requisitions ...................................................................................................................................... 14
Jobscience Managing Requisition Management User Guide (v. 3.5) 7



Chapter 2: Creating Requisitions
Creating Requisitions

When a position becomes available within an organization, the hiring manager must create a requisition before that 
position can be filled. You can create a new requisition at any time from within the New Personnel Action screen. 
You must fill in the Job Title field, but all other fields are optional. Please keep in mind that the more information 
you provide, the better able the recruiter will be to find the best Candidate for the position.

To create a new requisition

1. In the New Job Order Requisitions section, fill in the appropriate information for the new requisition:

■ Job Title--Enter the job title for this requisition. This field is required.

Note: These are sample pages and items. Your instance may look different depending on the customizations 
you requested from Jobscience and additional customizations you performed internally.

Please remember that access to parts of the product are dependent on individual user permissions and 
license limitations. Not all users will have access to everything described in this document.
Jobscience Managing Requisition Management User Guide (v. 3.5) 8



Chapter 2: Creating Requisitions
■ Department--Click  and select the department assigned to this requisition.

■ Position Seat Number--Click  and select the seat assigned to this employee. Depending on the size of 
the company and the way it is set up, Position Seat Number may be one of two things:

 An actual number that is assigned to each position within the organization. For example, if there are 10,000 
employees within an organization, there will be 10,000 position seat numbers ranging from 1 to 10,000.

 A job title. For example, Product Manager, Technical Writer, etc.
■ Approval Status--Select the current approval status for this requisition. Whether the requisition requires 

approval depends on who creates the requisition and what their position is within the company. If approval is 
required, select “Created” from the Approval Status list. For information on determining and setting approval 
status options, refer to Managing Configuration Settings on page 27.

■ Job Template--Click  and select the job template that will be used when the Job Order description is 
pulled from the requisition record once the requisition is approved (if approval is required).

■ Job Order--Leave the Job Order field blank. Once the requisition is created (and approved, if required) and 
the Job Order is created, the Job Order field will be back-filled with the name of the Job Order that was 
created for this requisition.

2. In the Requisition section, fill in the appropriate information for the new requisition:

■ Replacing Employee--If this requisition is replacing an employee, enter the name of the employee who is 
being replaced.

■ Position Type--Select the type of position from the drop-down list. Possible values are:

 New Full-time Employee Budgeted

 New Full-time Employee Non-Budgeted

 Replacement Full-time Employee Budgeted

 Replacement Full-time Employee Non-Budgeted
■ Rotating Shifts--Enable this checkbox if this position works a rotating shift.
■ Weekend and/or Holiday Rotation--Enable this checkbox if this position includes weekend or holiday work.
■ Shift Hours/Days--Enter a description of the shift and the hours required.
■ Additional Shift Details--Enter any additional details about the shift.
■ Hours per Pay Period--Enter the total number of required hours to be worked per payroll period.

3. In the Request Details section, in the Comments field, enter any additional information that may be helpful in 
obtaining approval for this requisition.

4. Click Save to create the requisition in the system. The new requisition is created and the Personnel Action 
screen displays with the information you provided.

Note: If the Job Template field is not displayed, then the Managing connector package is not installed. 
Please contact your system administrator for help with installing the connector package.
Jobscience Managing Requisition Management User Guide (v. 3.5) 9



Chapter 2: Creating Requisitions
Once a requisition is created, you can perform the following tasks:

■ View the requisition (refer to Viewing Requisitions on page 11).
■ Make changes to the requisition (refer to Editing Requisitions on page 13).
■ Delete the requisition from the system (refer to Deleting Requisitions on page 14).
■ Clone the requisition so you can use it when creating other requisitions (refer to Cloning Requisitions on page 

14).
■ Submit the requisition for approval, if necessary (refer to Submitting a Requisition for Approval on page 16).
■ Create a Job Order for this requisition (refer to Creating a Job Order on page 19).
Jobscience Managing Requisition Management User Guide (v. 3.5) 10



Chapter 2: Creating Requisitions
Viewing Requisitions
You can view a requisition at any time from within the Personnel Actions Home screen.

To view a requisition

1. Click the Personnel Actions tab to display the Personnel Actions Home screen.

2. If necessary, select the appropriate view in the View drop-down list. Requisitions associated with the selected 
view are displayed.

3. Click the link in the PAF # column to display the requisition in the Personnel Action screen.

Note: To learn more about creating new or editing existing List Views, refer to the Salesforce Help and 
Training. If you purchased Jobscience Premiere Support, contact Jobscience customer support for 
assistance.
Jobscience Managing Requisition Management User Guide (v. 3.5) 11
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4. If you want to make changes to the requisition, refer to Editing Requisitions on page 13 for more information.
Jobscience Managing Requisition Management User Guide (v. 3.5) 12



Chapter 2: Creating Requisitions
Editing Requisitions
Once a requisition is created, you can go back and make changes to it.

To edit a requisition

1. From the Personnel Actions Home screen, click the link in the PAF # column to display the requisition you 
want to edit. The Personnel Action screen displays.

2. Click the Edit button. The Personnel Action Edit screen displays.

3. Make any necessary changes and then click Save to save your changes, Save & New to save your changes 
and create a new requisition, or Cancel to discard your changes.
Jobscience Managing Requisition Management User Guide (v. 3.5) 13
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Deleting Requisitions
You can delete a requisition from the system at any time.

To delete a requisition

1. From the Personnel Actions Home screen, click the link in the PAF # column to display the requisition you 
want to delete. The Personnel Action screen displays.

2. Click the Delete button and then click the OK button in the dialog box that displays. The requisition is removed 
from the system.

Cloning Requisitions
Cloning allows you to quickly create a new requisition with the same information as an existing requisition. You can 
then change whatever information needs to be changed and keep the rest.

To clone a requisition

1. From the Personnel Actions Home screen, click the link in the PAF # column to display the requisition you 
want to clone. The Personnel Action screen displays.

2. Click the Clone button. The Personnel Action Edit screen displays.

3. Make any necessary changes and then click Save to save your changes, Save & New to save your changes 
and create a new requisition, or Cancel to discard your changes.
Jobscience Managing Requisition Management User Guide (v. 3.5) 14
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Chapter 3
Approving Requisitions

An approval process is an automated process your organization can use to approve records in Jobscience. An 

approval process specifies the steps necessary for a record to be approved and who must approve it at each step. 
A step can apply to all records included in the process, or just records that have certain attributes. An approval 
process also specifies the actions to take when a record is approved, rejected, recalled, or first submitted for 
approval. Once a requisition is created, it may require approval before the process can continue. Whether the 
requisition requires approval depends on who created the requisition, what their position is within the company, 
and how the product is configured for handling submissions and approvals. For information on approval settings, 
refer to Managing Configuration Settings on page 27. If the requisition does not require approval, you can skip the 
approval process and continue on with creating the Job Order. For information on creating Job Orders, refer to 
Creating Job Orders on page 18.

In This Chapter
Submitting a Requisition for Approval ............................................................................................................ 16

Approving a Requisition ................................................................................................................................. 16
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Chapter 3: Approving Requisitions
Submitting a Requisition for Approval
You can submit a requisition for approval once the requisition is created.

To submit a requisition for approval

1. From the Personnel Actions Home screen, click the link in the PAF # column to display the requisition you 
want to submit for approval. The Personnel Action screen displays.

2. Click the Submit for Approval button and then click the OK button in the dialog box that displays.

3. At this point, your company’s submittal and approval processes will determine how things proceed from here. 
For more information, refer to the Salesforce Help and Training.

Approving a Requisition
Once a requisition that requires approval is submitted, it must then be approved. Your company’s approval process 
will determine how this is done. For more information, refer to the Salesforce Help and Training.

If you are allowed to approve requisitions, there are two ways to determine which requisitions are assigned to you 
and waiting for you to perform an action in order to move them through the approval process:

■ From your Home Dashboard
■ From the Requisition Detail page

Viewing Requisitions from the Dashboard
You can view requisitions that were submitted and are awaiting your approval from your Home Dashboard. If you 
have added the Items To Approve related list to your custom home page layouts, then those items are displayed 
on your Home Dashboard. This provides you with an instant view of the approval requests that need your attention. 
From here you can choose to approve, reject, or reassign requisitions.

For more information on configuring your Home Dashboard, refer to the Salesforce Help and Training.
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Viewing Requisitions from the Detail Page
You can view requisitions that were submitted and are awaiting approval from the Personnel Action Detail page 
for a specific requisition.

The Approval History panel displays the approval history for submitted requisitions. The Assigned To column 
displays the person who is responsible for approving each requisition. From here you can choose to approve, 
reject, or reassign requisitions that are assigned to you.
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Creating Job Orders

The Hiring Manager is responsible for creating a requisition when there is a job opening to fill. Once the requisition 

is created and approved (if necessary), then it is the Recruiters responsibility to create the Job Order for that 
requisition. The Recruiter uses the requisition to obtain as much information as possible about the job opening and 
the type of Candidate they are looking for. Therefore, the more information the Hiring Manager includes in the 
requisition, the more it will help the Recruiter in finding the best Candidate for the job.

Note: In order for the recruiter to access the requisition, the Managing connector package must be installed.

In This Chapter
Creating a Job Order ..................................................................................................................................... 19
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Creating a Job Order
Once a requisition is approved (if approval is required), you can create the Job Order for that requisition. If you try 
to create the Job Order before the requisition is approved, or if the current status does not match the required 
approval status (as specified by the Approved Status option), then the following error message is displayed.

To create a Job Order

1. From the Personnel Actions Home screen, click the link in the PAF # column to display the requisition you 
want to submit for approval. The Personnel Action screen displays for the selected requisition.

2. Click the Create Job button. The Create Job screen displays.

3. In the Information section, fill in the appropriate information for the new Job Order:

■ Select the Record Type for this Job Order.

Note: You can configure the Approval Required and Approved Status settings. For information on 
configuring approval settings, refer to Managing Configuration Settings on page 27.

Note: The Job Title field must be filled in on the requisition before the Job Order can be created.

Note: You have the ability to show or hide specific fields on the Create Job screen. For information on 
showing and hiding these fields, refer to Config Settings on page 28.
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■ Select the Job Function for this Job Order.
■ Select the Department for this Job Order. If a department was selected when the requisition was created, 

then the Department is populated.
■ Select the Location for this Job Order.

■ Click  and select the Primary Recruiter who is assigned to this Job Order.

■ Click  and select the Secondary Recruiter who is assigned to this Job Order.

4. Click the Create Job button to create the new Job Order.

Once the Job Order is created, the requisition and the Job Order are tied to each other. If you view the requisition, 
the Job Order field is populated with the name of the Job Order.

If you view the Job Order, the Requisition field is populated with the name assigned to the requisition.

In addition, the new Job Order is populated with specific information that was pulled from the requisition:

■ Department Name--If a Department was selected when the requisition was created, then the Department 
Name is populated on the Job Order.

■ Position Seat Number--If a Position Seat Number was selected when the requisition was created, then the 
Position Seat Number is populated on the Job Order.

■ Paygrade--If a Paygrade is assigned to a position seat number and that position seat number is assigned when 
the requisition is created, then the Paygrade is populated on the Job Order.
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Chapter 5
Reports

A report returns a set of records that meets certain criteria, and displays it in organized rows and columns. Report 

data can be filtered, grouped, and displayed graphically as a chart. Reports are stored in folders, which control who 
has access. You must have “Read” permission on the records included in your reports; otherwise, when you run 
them, they may be missing data or appear blank. To help you monitor your organization, there are a wide range of 
standard reports, accessible in standard report folders on the Reports tab. You can also create new custom reports 
to access exactly the information you need, subtotal and limit your data to help you analyze trends and get a 
concise picture of what is happening in your organization.

Note: This chapter provides basic report information. For more detailed information, refer to the Salesforce 
Help & Training.

In This Chapter
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Creating Reports ............................................................................................................................................ 23

Editing Reports............................................................................................................................................... 24

Deleting Reports ............................................................................................................................................ 24

Running Reports ............................................................................................................................................ 24
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Exporting Reports .......................................................................................................................................... 25
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The Reports Tab
When the Reports tab is selected, the Reports Home page is displayed. From this page you can perform the 
following actions:

■ Search for reports
■ Select or create a folder
■ View individual or all reports
■ Create reports
■ Edit reports
■ View recently viewed, created, or modified reports
■ Delete reports
■ Schedule reports
■ Run reports
■ Export reports
■ Follow or stop following a report in your Chatter feed

Note: The actions you are able to perform are dependent upon your individual user permissions. If you need 
assistance with your permissions, please contact your system administrator.
Jobscience Managing Requisition Management User Guide (v. 3.5) 22



Chapter 5: Reports
Creating Reports
To create a report

1. Click the Reports tab to display the Reports Home screen.

2. Click the Create New Custom Report button. The Create New Report screen displays.

3. Select the category and the report type, and then click the Create button. The Unsaved Report screen 
displays.
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4. Click the Save button. The Save Report dialog box displays.

5. Enter the Report Name, the Unique Report Name, and any other information you want to include, and then 
click the Create button. The report displays.

For more information on creating reports, refer to the Salesforce Help & Training.

Editing Reports
To edit a report

1. From the Reports Home screen, locate the report you want to edit.

2. Click the Edit link in the Action column next to the report. The report displays.

3. Make changes and then click the Save button.

For more information on editing reports, refer to the Salesforce Help & Training.

Deleting Reports
To delete a report

1. From the Reports Home screen, locate the report you want to delete.

2. Click the Del link in the Action column next to the report and then click the OK button when the dialog box 
displays. The report is deleted from the system.

For more information on deleting reports, refer to the Salesforce Help & Training.

Running Reports
To run a report

1. From the Reports Home screen, locate the report you want to run.

2. Click the Report Name link to display the report.

3. Click the Run Report button and choose Run Report Now from the drop-down list.

For more information on running reports, refer to the Salesforce Help & Training.

Scheduling Reports
To schedule a report to run

1. From the Reports Home screen, locate the report you want to schedule.

2. Click the Report Name link to display the report.

3. Click the Run Report button and choose Schedule Future Runs... from the drop-down list.

4. Enter the appropriate information and then click the Save Report Schedule button.

For more information on scheduling reports, refer to the Salesforce Help & Training.
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Exporting Reports
To export a report

1. From the Reports Home screen, locate the report you want to export.

2. Click the Export link in the Action column next to the report. The Export Report screen displays.

3. Select the appropriate information for Export File Encoding and Export File Format and then click the Export 
button.

4. Choose to open or save the report file.

For more information on exporting reports, refer to the Salesforce Help & Training.
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Chapter 6
Administration

This chapter describes administrative tasks that can be performed with the Jobscience Managing product.
In This Chapter
Managing Configuration Settings................................................................................................................... 27

Config Settings............................................................................................................................................... 28
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Managing Configuration Settings
Within Custom Settings, the Managing Configuration option allows you to configure approval and sharing settings.

Approval Required: If selected, the requisition must have an approval status equal to the value(s) entered in the 
Approved Status field in the custom settings. If not selected, the Approval Status field on the requisition is 
ignored, and the create job process can be run at any time.

Approved Status: If the Approval Required setting is disabled, this setting is ignored. If the Approval Required 
setting is enabled, then the Approval Status field on the requisition must be equal to one of the values entered in 
the Approved Status field in order to move forward with the create job process. Multiple, comma-separated values 
may be entered in this field.

Hiring Manager Sharing: In a Private Model, this setting allows the client to control how to share the Job Order 
record with the Hiring Manager field on the Job Order. Possible values are:

■ N=no access
■ R=read only access
■ RW=read/write access

Primary Recruiter Sharing: In a Private Model, this setting allow the client to control how to share the Job Order 
record with the Primary Recruiter field on the Job Order. Possible values are:

■ N=no access
■ R=read only access
■ RW=read/write access

Secondary Recruiter Sharing: In a Private Model, this setting allows the client to control how to share the Job 
Order record with the Secondary Recruiter field on the Job Order. Possible values are:

■ N=no access
■ R=read only access
■ RW=read/write access

Note: If an approval is not required, you can remove the Approval Status field from the Page Layout to avoid 
confusion. 
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Config Settings
Within Custom Settings, the Config option allows you to specify which fields displays on the Create Job screen.

Job Template: Enable Department field: If selected, the Department field displays on the Create Job screen; if 
not selected, the Department field does not display on the Create Job screen.

Job Template: Enable Job Function field: If selected, the Job Function field displays on the Create Job screen; 
if not selected, the Job Function field does not display on the Create Job screen.

Job Template: Enable Location field: If selected, the Location field displays on the Create Job screen; if not 
selected, the Location field does not display on the Create Job screen.

Job Template: Enable Primary Recruiter: If selected, the Primary Recruiter field displays on the Create Job 
screen; if not selected, the Primary Recruiter field does not display on the Create Job screen.

Job Template: Enable Secondary Recruiter: If selected, the Secondary Recruiter field displays on the Create 
Job screen; if not selected, the Secondary Recruiter field does not display on the Create Job screen.
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